DP5 Quick Start Guide Rev C0

DP5 QUICK START GUIDE (FW6)
The Amptek DP5 Digital Pulse Processor is strictly an OEM product.
Please refer to the DP5 documentation for information on the use and
hardware setup of the DP5. This Quick Start Guide only describes the
software setup using a USB connection. The manner in which the DP5 is
both powered and connected to the PC’s USB port varies depending on
whether the DP5 is bought stand-alone, or with a PC5. Those connections
are not addressed here.
For help using the software please see the Help File in the DPPMCA
software. Go to the Help menu and select Help Topics or press F1 on the
keyboard. The Help File contains quick start guides and “how to”
instructions for many common tasks.

Software Installation
1. Install the WINUSB Driver. Please see the “WINUSB Driver Installation Instructions” for this procedure. It is
highly recommended to use Windows Update to install the USB driver.
2. Install he DPPMCA display and acquisition software. Locate the directory called “DPPMCA” on the Amptek
Installation CD and copy the entire directory onto your computer. In that directory is the “DPPMCA.exe” file.
Open this file to start the software. You can right-click on the DPPMCA.exe file and create a shortcut which
can be placed on your desktop for easy access.

DP5 Connection Instructions
1. Verify that the DP5 is completely unplugged (both USB and power).
2. Use the USB cable to connect the DP5 USB connector to the PC’s USB connector.
3. Plug the DC power supply into a 110/220 AC outlet. Connect the other end to the DP5 power supply input.
NOTE: Grounding is critical to obtaining the best performance. We strongly recommend using a single point
ground for the system. To ensure this, use a 3-prong to 2-prong adapter on the power supply of any
notebook computer. This prevents the notebook from introducing another ground into the system.

Quick Use of the DP5
1. Connect the DP5 and PC as described in the previous section.


The DP5 stores its configuration, so when powering the system initially, the factory configuration is loaded.
If you modify the configuration, the last configuration is loaded.

2. Launch the DPPMCA software by opening the DPPMCA.exe file.
3. Connect to the DP5
a. The connection dialog will appear when DPPMCA is launched.
b. Select which interface you will use (USB, Ethernet, or RS232).
c. If more than one device is available, select the device you want.
d. Click "connect."
4. Configure the DP5
a. The most commonly changed parameters are the gain and the thresholds.
 To quickly change the gain, use the gain increment (decrement) buttons on the toolbar.
 After changing the gain, remove all excitation sources, start an acquisition, then click the "Tune Slow/Fast
Thresholds" button on the toolbar.
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b. For all configuration parameters, click
, or press F9, or go to the DPP menu and select DPP Setup. Once
you have changed a parameter, click the "Apply" button to send it to the DP5.
c. Within the DPP Setup dialog box, you can load a default configuration file for your detector or you can save
and load custom configurations.
d. Configuration Tips
 Changing the gain changes the full scale energy range. For example, a gain of 100 may correspond to a
full scale energy of 15 keV, while a gain of 50 will have 30 keV full scale.
 It is necessary to readjust thresholds (click the tune slow/fast button) whenever the gain is changed and
suggested when any parameter is changed.
 You may want to first take a spectrum and measure the energy range, to verify functionality and to
determine the needed gain.
5. Acquire data
a. Place a source in front of the detector.
b. To start or stop acquisition, click the "start/stop" icon in the toolbar or press the space bar.
c. To clear the data and time, click the “delete data and reset time" button in the toolbar or press "A" on the
keyboard.

d. Data Acquisition Tips
 It can take minutes for an Amptek detector to stabilize after power has been applied or a configuration
changed. If the spectrum looks odd, clear the data and restart.
 You can tell that data are being acquired if (a) the spectrum appears in the window, (b) the input and total
counts are increasing, (c) the accumulation time is increasing, and (d) the "status" in the right hand Info
Panel reads "acquiring."
 You can set the DP5 to stop acquisition after a fixed time, after a fixed number of counts are collected,
and with other options using the MCA tab on DPP setup.
6. Display data
a. The spectrum, counts, and accumulation time are automatically displayed as data are acquired. If a region of
interest is defined and selected, its net area and other properties are also shown.
b. To zoom in on a portion of the spectrum, use the arrows at lower right. To return to the full screen view, use
the full range arrows on the toolbar.
c. To toggle between a linear and a logarithmic vertical scale click on the spectrum and press "L" on the
keyboard or select the scale from the Display menu.
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DPP Config Data

Count Data

ROI Data

Power Data

d. The primary data from the DP5 are the spectrum and the count rates. There are auxiliary outputs on the DP5.
These are useful for interfacing the DP5 with other hardware. They are described in the DP5 user manual.
7. Analyze data
a. Regions of Interest
 A Region of Interest (ROI) is an area marked as a potential peak in a spectrum.
 DPPMCA supports several ways to mark or define an ROI. The easiest way is to place the cursor at the
left edge (lowest channel) of desired region and then press and hold the "U" key until the peak is
highlighted and the upper edge is reached. You can also click on the Mark ROI button on the toolbar and
then click and drag the cursor over the peak.
 For each ROI, DPPMCA computes the total counts (gross area), subtracts the background, and for the
difference computes the net area, centroid, and peak width. The resolution is also displayed.
b. Energy calibration
The native scale (x-axis) of the hardware is channels. Most often you will want to convert the channel scale
to energy.
1. Chose the two peaks that will be used for the calibration and make note of their energies.
2. Mark an ROI (region of interest) around each peak. This can be done by clicking the cursor at the left
base of the first peak and then holding down the “U” key on the keyboard until the whole peak is
highlighted, or by using the Edit ROI button on the toolbar and then clicking and dragging across the
peak until it is highlighted.
3. Now click in the toolbar button “Calibrate” (F5) to open the calibration dialog box.
4. Move the dialog box such that both peaks are visible and then click the cursor into the first peak. The
peak should be highlighted and the Peak Information section on the right-hand information panel should
be filled in. If the peak is highlighted and there is no peak information, then the ROI is not marked
correctly. Try adjusting the start and end points of the ROI.
5. Click the Centroid button on the dialog box. This will enter the center position of the peak into the
Channel box. Then enter the energy of that peak into the Value box, e.g. 6.4, and click Add.
6. Now click the cursor into the second peak (it will highlight). Click on Centroid, enter the second energy,
e.g. 17.48, and click Add. There should now be two lines in the box.
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7. In the Units box type in the energy units, e.g. keV.
8. Click OK. The scale should now be in energy. If it is not press F7, this toggles between calibrated units
and channels.

8. Save and load data
a. To save a data file, click the "File Save" icon or select Save As from the File menu. Data are saved in an
ASCII file format with a .mca extension which includes the counts in each channel, slow and fast counts, ROI
and calibration data, and the DPP configuration parameters. This file can be opened in notepad, Excel, etc.
b. To load a saved data file use the "File Open" icon. The ROI and Calibration data from a stored file can be
transferred to a spectrum being analyzed or can be automatically loaded when you open DPPMCA (View
menu -> Preferences-> General Tab).
c. To process the data using a different software package the .mca file can be opened as a text file. Alternately,
you can click "Ctrl-R" to copy the data to the Clipboard, then paste it where desired, e.g. in Excel.
d. To print a spectrum press "Ctrl-P" or the "Print" icon on the toolbar.

Amptek Inc.

Page 4 of 6

DP5 Quick Start Guide Rev C0

Troubleshooting the DPPMCA Software
If you cannot connect to the DP5 check the following:
 Was the software correctly installed?
 Were the drivers properly installed?
 Are all the cables connected?
 Is the DP5 power plugged in?
If you start an acquisition but see no counts:
 Is there an isotopic source in front of the detector or is the X-ray tube turned on?
 Is the DPP configured properly?
o Amptek provides a set of default configuration files. If you are having problems, we recommend
loading one of these defaults. It may not be optimum for your experiment but should get you started.
Open the DPP Properties->General tab and select a configuration from the drop-down.
Does the polarity of the HV bias set in software match that set in hardware?
 Amptek SDD detectors require NEGATIVE HV.
 Amptek Si-PIN and CdTe detector require POSITIVE HV.
o Check the info pane to see if the HV is enabled (if not, the reported value will be a few volts) and
check the polarity. The HV is set and enabled on the Power tab of the DPP Properties.
Are the input polarity and offset correct?
 Pulses of the wrong polarity or with an incorrect input offset will be outside the range of the ADC and
therefore not measured. Verify the input polarity and set the input offset to “default.”
o Amptek SDD detectors require POSITIVE input polarity.
o Amptek Si-PIN and CdTe detector require NEGATIVE input polarity.
Are pulse selection settings rejecting everything?
 The pile-up rejection and rise-time discrimination circuits will reject from the spectrum events which do
not meet certain criteria (discussed in the manuals). If the system is configured incorrectly, it is quite
common for no pulses to be recorded. Turn off PUR and turn off RTD while you are setting up and
debugging the system. Most systems will work best with PUR enabled, once everything else is configured
properly. RTD is an advanced setting and we recommend most users leave it disabled.
Are the thresholds correct?
 Always click the Tune Slow/fast thresholds button on the toolbar (with no source in front of the detector).
This automatically sets the slow (LLD) and fast thresholds. It is recommended to click the tune slow/fast
thresholds button whenever you change a setting.


The Fast and Slow Thresholds can also be adjusted manually. First turn off PUR as described above. Then
click the cursor to channel 1 and press F8. This will set the Slow Threshold (LLD) to channel 1. This will
show the noise of the system. Click the cursor just to the right of the noise and then press F8. Press the
“A” key to clear. There should be no counts accumulating. Now put the device into “Delta” mode (only
one second’s worth of data is displayed every second) by clicking the Delta button on the toolbar. Open
the DPP properties and go to the Shaping page. Adjust the Fast Threshold until 5 to 10 counts per second
appear in the Input Counts in the right-hand Info Panel. Now turn on PUR and click OK. Click the Delta
button to get back to normal MCA mode and put the source back in front of the detector. The Input Counts
should slightly exceed the Total Counts at low count rates. The Total Counts should always be less than
the Input Counts. If they are not, then thresholds are not set correctly.

If you still do not see a spectrum or the correct spectrum, save a .mca file from the File menu and email it to
sales@amptek.com. This files contains important information that will help Amptek troubleshoot the problem. Do
not send screen shots or any other type of file. Only the .mca file is needed.
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Firmware Notes
How can I tell if my DP5 or X-123 with a DP5 has FW5 or FW6?
If your unit was shipped before November 15, 2011 it has FW5. If was shipped on or after November 15, 2011 it
has FW6.
If your unit connects to the ADMCA application software it has FW5. If it connects to the DPPMCA application
software it has FW6.
Do I have to rewrite custom software that I developed for FW5 to support FW6?
Yes. FW6 is NOT backwards compatible with FW5. It uses an new protocol. You must implement the Software
Developer’s Kit (SDK). The old DPP API is NOT compatible with FW6.
FW6 SDK: http://www.amptek.com/dp5_sdk.zip
Which firmware version will be supported by Amptek going forward?
Only FW6 will be supported going forward. There will be no future upgrades or bug fixes to FW5. All new
functionality will be incorporated only into FW6. Amptek strongly recommends that users of FW5 migrate to the
FW6 platform as soon as possible. For this reason Amptek supplies a firmware uploader so that you can easily go
back and forth between the firmware versions. This will allow you to develop new software on your own timetable.
Firmware Loader: http://www.amptek.com/uploader.zip

Windows 7 Compatibility Document: http://www.amptek.com/pdf/win7upgrade.pdf
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